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RECOMMENDED COURSE OF ACTION

Please read through this documentation and then go though the tutorial in

column F of zWNDMSTR.xlw. To print out this documentation and the tutorial,

click on the "PRINT DOCS/TUTORIAL" icon above. To view the tutorial now,

click on the "GOTO TUTORIAL" icon above.

PRINTING DOCUMENTATION

Immediately prior to printing this full documentation or the "quick and

dirty" documentation in zWNDMSTR.xlw ("Quick Reference"), please choose

File-Page Setup-OK to adjust each document to your printer. If you have any

problem printing, try adjusting Page Setup, Set Print Area, and margin breaks

then select File-Print like you would when printing almost any Excel document.

INTRODUCTION

• This set of macros is designed to facilitate the management of Excel windows.

• It can provide you with a wide list of all open windows, from which windows can

be chosen to activate.  This avoids Excel's display under the "Window" menu, which is

limited to nine windows.  It also avoids Excel's narrow dialog box, which is displayed if

you choose "More Windows" under the "Window" Menu. Also, the unhiding of a

window selected from the list is automated. Multiple windows can be simultaneously

selected to activate.

• What if you have created a chart, and now you want to look at the data that are the

bases of the chart? Ordinarily, you must first activate the appropriate worksheet

and then find the cells containing the data. A macro here transports you directly to

the appropriate open worksheet and to the cells that are the bases of the chart.

Simply copy the formula from the chart's formula bar, press command-period,
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then select the macro's "Goto Wrksht/Cells: Use Clipboard" command.

• Excel's "Save Workspace" command can be very useful in reopening the Excel

files that you were using at a previous session. But Excel does not allow you to

reopen a subset of a workspace. A macro here allows you to select all or any

parts of a list of files.

• You have a complex formula in a worksheet that refers to another worksheet or

a part of the same worksheet, and you want to be transported to some of the

cells referenced in part of the formula. The Window Meister (TM) easily takes

you there with a copy operation and a command.

• You have several files open. You absolutely know that now you don't want to

save any of them so you want to avoid responding to Excel's save-dialog boxes.

Give The Window Meister one command and respond to one dialog box and you'll

be out of Excel in zip!

• For a description of these and other commands, see below.

INSTALLATION OF THESE MACROS:

(WARNING: Failure to properly install these macros probably will

result in unpredictable performance.)

Be sure that you have no Excel files with a name beginning with the letters

"zWNDMSTR" or beginning with "z_" (letter "z" followed by an underline).

Similarly, subsequent to installation, avoid having any Excel file open that begins

with "zWNDMSTR" or "z_." This will help assure that The Window Meister uses the

correct files in its operations. To install The Window Meister, select the

zWNDMSTR.xlw, z_DOCS.xlw, & z_Archv.xlw files and the zMacro folder and drag

them onto your hard disk where you wish to install them; be sure to put all of them

in the same folder.  Open zWNDMSTR.xlw in Excel 3.0a. Don't worry if you get an

error message when zWNDMSTR.xlw loads.  If you get the error message, select

"Links..." under the "File" menu.  In the dialog box that appears, select

"z_Macros.xlm" and then click once on Change.  Now, in the same dialog box,

navigate folders and drives to find the zMacro folder (wherever you put it). Double

click the folder to open it.  Click once on "z_Macros.xlm" and then once on "Change." 

Save zWNDMSTR.xlw. You are done! From now on, when you open zWNDMSTR.xlw,

the appropriate macros should automatically be loaded.  If you move the zMacro

folder, you may need to repeat this process so that Excel can find z_Macros.xlm.

BASIC PURPOSES OF LISTS

The utility of the Window Meister (TM) set of Excel programs heavily depends

upon three lists. Here are the lists and their primary purposes.

(1) List of Open Windows: This lists the names of the open Excel windows that

exist at the time that this list is created. It can be used to activate windows on

the list. It can accommodate up to about100 windows, thereby avoiding the

"More Windows" selection under Excel's "Window" on the menu bar. In addition

to accommodating up to 100 windows, this list is much wider than the list that

Excel provides through "More Windows, and unlike the list furnished through
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"More Windows," it includes hidden windows.

(2) List of Files: This lists the names of the Excel files that are open at the time

that this list is created. The full path of each file is included so that this list can

be used to easily reopen files. It also provides the foundation for the Archived

List of Files.

(3) Archived List of Files: Like the List of Files, this lists the names and

paths of Excel files. And, like the List of Files, this list can be used to

easily reopen files. The most important difference between the Archived

List of Files and the List of Files is that the file names and paths in the List

of Files are replaced each time it is updated, whereas the Archived List of

Files in intended as relatively permanent storage for file names and paths.

Files on each of these lists generally include macrosheets (except 

z_Macros.xlm), worksheets, and charts that are hidden and unhidden.

BASIC STRUCTURE AND PROCESSES OF LISTS

These macro programs extensively use the three lists. Therefore, to get the most

out of these programs, it may be helpful to explain the lists from the perspective

of their basic structure and processes. The three lists are the List of Open

Windows, a List of Files, and an Archived List of Files. The first list, a List of

Open Windows, is created upon opening zWNDMSTR.xlw and created upon user command.

The second list, a List of Files (complete with their paths), is created only upon

user command. This allows a List of Files, which includes all files open at the

last Excel session, to be easily reopened at the next session; to enable this

feature, simply use The Window Meister's "- Update List of Files" command when you

want to record the list of files to be later reopened, then save the zWNDMSTR.xlw

worksheet, then at a subsequent Excel session, select The Window Meister's "Open

Files: Use Last List" command and select which of the files you want to reopen. The

third list, an Archived List of Files (complete with their paths), is supplemented

with the current List of Files only upon your command; its lists can be used to

reopen Excel files at subsequent Excel sessions. Moreover, you can reopen a

combination of Excel files from anywhere on a list archived in the Archived

List of Files. In summary, the List of Open Windows is automatically created at the

time that the "zWNDMSTR.xlw" worksheet is initially loaded into RAM, and you can

update this list. The other two lists are produced only at your command. The List

of Open Windows and List of Files are replaced each time they are updated. The

Archived List of Files is meant to permanently store lists of files in the

worksheet called z_Archv.xlw. The List of Open Windows and List of Files are stored

in the worksheet, "zWNDMSTR.xlw".

To get an idea of the power of these lists, be sure to try out the tutorial 

in column F of zWNDMSTR.xlw.

THE WINDOW MEISTER'S FILES

The Window Meister consists of four files: zWNDMSTR.xlw, z_Macros.xlm, 

z_DOCS.xlw, & z_Archv.xlw.
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(1) zWNDMSTR.xlw: This is the worksheet in which names of your windows and files

are recorded. It, therefore, includes the List of Open Windows and the List of

Files. It also includes a brief version of the documentation, called "Quick

Reference," and, in its column F, a brief tutorial illustrating some of The Window

Meister's power. Opening zWNDMSTR.xlw automatically opens z_Macros.xlm.

(2) z_Macros.xlm: This is the macrosheet containing the macro programs.

(3) z_DOCS.xlw: This is the worksheet that you are now reading. It contains

more complete documentation than zWNDMSTR.xlw.

(4) z_Archv.xlw: This worksheet is intended for "permanent" storage of your Lists

of Files.

WARNINGS

These macros have been used with Excel 3.0a many times without any serious problem,

but try them at your own risk. Suggestion: first experiment on "throw away" files.

 Many precautions have been taken towards assuring the password protection of the

macrosheet. Attempts to break through that protection may produce results that you

cannot predict. The Window Meister (TM) may read and write to disk often. And,

perhaps invisible to the user, it does extensively use the clipboard, thereby replacing

previous clipboard contents and thereby activating Excel's normal clipboard

functions, such as, when the Enter key is pressed, pasting in cell(s) copied by the

macro. Two implications of this clipboard use are: (1) beware that when a macro is

selected, previous clipboard contents may be replaced; (2) the user should be

careful when pressing Enter after using one of the macros of The Window Meister.

UNAUTHORIZED CHANGES

Changing any part of The Window Meister (TM) or any of its files, except as

produced or prompted by it, may seriously affect how it performs and render

its performance and operations unpredictable. Do NOT change the names of

any of its files or the name of the folder ("zMacro") or the location of

the file named "z_Macros.xlm" within its folder. Do NOT attempt to unprotect

the file named "z_Macros.xlm" or the file named "z_DOCS.xlw."

SOME LEGAL STUFF

The Window Meister (TM) is a trademark owned by Stephen R. White. Stephen

R. White owns the copyright to The Window Meister and all parts of it

and reserves all rights to it and all of its parts and processes. The

Window Meister, including its folder(s), each of the four files

described above, the content of each of those files and folder(s), and

anything produced or caused by any of them, are provided "as is," without

any warranty of any kind. There is no warranty, express or implied, of any

kind pertaining to any part of these files and folder(s), any part of their

contents, or any part of their products, nor is there any such warranty

regarding any combination of their files, folder(s), contents, or products.

The user assumes all risk and all direct and indirect incidents and all
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direct and indirect consequences of the risk of using The Window Meister

or any part of it. The terms of the use of The Window Meister

and the terms of this paragraph shall be governed by the laws of North

Carolina and, when applicable, the laws of the United States of America. By

using The Window Meister or any part of it, the user represents that

he/she has read all of Column B of z_DOCS.xlw and agrees to abide by all

of its content, including, but not limited to, the terms contained on the

Shareware Registration Form.

STARTING THE WINDOW MEISTER

You do NOT open the macrosheet (z_Macros.xlm). You open zWNDMSTR.xlw; 

it automatically opens the macrosheet (z_Macros.xlm). When they are

opened, these two files work together and read from, and write to, disk.

During this opening process, a List Open Windows is created in zWNDMSTR.xlw

and you are asked whether you want zWNDMSTR.xlw continuously visible.

Keeping it continuously visible may speed up some of the macros, but,

of course, this adds a window to your screen. When the macrosheet loads 

into memory, it automatically inserts "W" on the right side of the menu 

bar and automatically activates Excel's full menus.

CLOSING THE WINDOW MEISTER

When you finish using The Window Meister and you wish to close it, closing

zWNDMSTR.xlw automatically closes the macrosheet (z_Macros.xlm).

You can close zWNDMSTR.xlw the usual Excel ways or you can close it by

selecting "Close zWNDMSTR" under the "W" menu on the menu bar. You

should save zWNDMSTR.xlw before closing it if you wish your last

created List of Files available when you open zWNDMSTR.xlw the next time.

Similarly, save z_Archv.xlw before closing it in order to retain additions 

to it since the last save. Whether YOU save z_Macros.xlm is generally irrelevant.

MACRO'S COMMANDS (UNDER W ON THE MENU BAR)

• W

On the menu bar, this is where you can drag-select any of the following

commands.

• Paste file name/cells refer.

This macro copies to the clipboard references to the selected cell(s) or active Excel

window; the reference can then be pasted in an Excel cell with the command-v

command. The user optionally can include a date & time log in the pasted

information. Note that since a cell from the macrosheet is being pasted, any action

that eliminates the readiness of a copied cell to be pasted will eliminate the ability

to paste the reference; in such an event, you can repeat the procedure for this

command.

• Save As: Use Clipboard for Name

Saving a series of files with similar names is facilitated with this macro. Suppose you
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have a chart named "Consolidated Report Division 3a," and now you wish to save

another chart and name it "Consolidated Report Division 3b." A number of the other

macros in The Window Meister enable you to copy the name "Consolidated Report

Division 3a" to the clipboard from Excel's formula bar. Once in the clipboard, this

macro presents Excel's Save dialog box with the copied name already in it. You can then

easily edit the name of the file in the dialog box, for example by changing the "3a" to

"3b." In sum, to use this macro, copy something into the clipboard by drag-selecting it

from the Excel formula bar, press command-c, de-select the formula bar [e.g., by

clicking on the cancel box (     ) in the formula bar], select the Window Meister

command "Save As: Use Clipboard for Name," select the destination of the file and edit

the file's name in Excel's Save dialog box as you normally could, then select OK.

• Goto Cells this Wrksht: Use Clipboard

This macro command transports you to cells corresponding to a reference in the

clipboard. To use this macro, the referenced cells must be in the same worksheet as

the active cell in the active worksheet. E.G., if the active cell is A5, which contains

the formula "=((SUM(AA1:AA6))+(SUM(AE4:AE9))+A184)/A205," and if you

want to go to AE4:AE9, you drag-select the reference, copy the selection to the

clipboard, de-select the formula bar [e.g., by clicking on the cancel box (     ) in the

formula bar], then choose this macro command. An example of a drag-selected

reference:

• Goto Wrksht/Cells: Use Clipboard

This macro performs the same function as the preceding one, except that it can

transport you to, and unhide, an open Excel file different from the one currently

active. The macro is especially useful to look at the data underlying a chart. For

example, to look at the data underlying series 3 of a chart, you would drag-select

the full reference to the open worksheet and cells, copy that reference to the

clipboard, de-select the formula bar (e.g., by pressing command-period), then

select this macro command. Here is what this drag-select operation might look like

in this example.

• Activate Window: Use Clipboard

This macro is similar to the preceding one, except that it does not select any

specific cells in the activated window. This macro activates a window of a file

open & represented by its name already in the clipboard. Only the name of the

file should be in the clipboard when the macro is started.  E.g, the name

might be drag-selected and copied from a series of a chart to activate the

worksheet underlying the chart's data.

• Activate Window: Use List
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Avoids navigating through "More Windows" under Excel's "Window" menu when

there are more than 9 unhidden windows. With one operation, it also will activate

and unhide a hidden window.  The list can handle up to about 100 open Excel

windows, including hidden and unhidden, charts, worksheets, and macro sheets, but

excluding The Window Meister's macrosheet. The dialog box that asks you to select

the window appears at the bottom of the window that has the list of windows in it.

Therefore, you can affect where this dialog box appears by resizing the height of the

window with the list in it. You might want to experiment with this feature to

maximize your screen space.

• Activate WindowS: Use List

This performs the same function as the preceding macro, except it can activate and

unhide more than one window. DIscontinuous cells in the List of Open Windows can

be selected to choose the files to activate and unhide. This macro usually is a bit slower

than "Activate Window: Use List." Like the preceding macro, the dialog box that asks

you to select the windows appears at the bottom of the window with the list of

windows in it. Therefore, you can affect where this dialog box appears by resizing

the height of the window with the list in it. You might want to experiment with this

feature to maximize your screen space.

  Updates the list used in the preceding two commands, such as when the user

  creates more documents after the macrosheet loads into memory. In other

  words, for the use of "Activate Window: Use List" and "Activate WindowS: Use

  List," The Window Meister makes a list of all Excel windows open at the time

  that zWNDMSTR.xlw and z_Macros.xlm load into memory; this macro allows the

  user to update that list. The maximum number of windows remains at about

  100. The new list replaces the old list.

• Hide All Windows

Hides every Excel window that is unhidden and open at the time this command is given.

• Open Files: Use Clipboard

Opens a file represented by its name already in the clipboard. The full file path

usually must be in the clipboard for this macro to work reliably. E.g., to open an

Excel file called "FREQ_ETC.xl," which is found in the Excel Startup Folder of the

System Folder on the hard drive called "IHD," the user would drag-select the

following from the formula bar, copy it to the clipboard, then select this macro

command:

Copying a cell as a cell also will work if the cell only contains the file reference. 

Note that such formatted references are produced by The Window Meister's 

"-Update List of Files" and "Archive File List" commands.

• Open Files: Use Last List

In one operation, will open multiple files from the last updated List of Files.

Discontinuous cells can be selected to choose files to be opened. The List of Files

used for this macro is created by executing the next macro. Unlike the List of

 • - Update List of Windows
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Open Windows, this List of Files is not created automatically when The Window

Meister loads into memory. This allows you, in a subsequent computer session,

 to easily reopen all or some of the files on the last saved  List of Files.

The dialog box asking you to select the files appears at the bottom of the window with

the List of Files in it. Therefore, you can affect where this dialog box appears by

resizing the height of the window with the list in it. You might want to experiment

with this feature to maximize your screen space.

  Creates or updates the list used in the preceding command. This List of

  Files, which includes file paths, constitutes the names and paths of Excel

  files that are open at the time that you select this command. A file that has

  not yet been saved when this macro is run results in an asterisked entry and

  incomplete path for that file in the List of Files. Note that the file path

  and file name in this list do NOT automatically change if you rename or move

  a file to another location, e.g. to another folder or disk. In such a case,

  ordinarily you would run "-Update List of Files" to update the List of Files

  to reflect the changes. The new list replaces the old list.

• Open Files: Use Archive List

In one operation, opens multiple files selected in a column of the worksheet called

"z_Archv.xlw." Discontinuous cells can be selected from an archived list of files

to choose files to be opened. The dialog box that asks you to select the files appears

at the bottom of the window with the archived list of files in it (z_Archv.xlw).

Therefore, you can affect where this dialog box appears by resizing the height of the

z_Archv.xlw window.  You might want to experiment with this feature to maximize

your screen space.

• Archive File List

Puts the last List of Files, including their paths, on a master worksheet

(z_Archv.xlw) for "permanent" storage. Later, this list can be used to open

several files in one procedure through the "Open Files: Use Archive List"

command.  Columns A to Z of z_Archv.xlw are already formatted for you.

• Goto List of Open Windows

Takes you to the List of Open Windows.

• Goto List of Files

Takes you to the List of Files.

• Goto Archived List of Files

Takes you to the List of Files that was last archived in z_Archv.xlw.

• Goto Quick Reference

Takes you to a briefer version of this documentation.

• Goto full documentation

Takes you to this documentation.

• Set Keyboard Equivalents

This command allows you to set current keyboard equivalents for "Paste file

name/cells refer.," "Activate Window: Use List," "Activate WindowS: Use List," and

 • - Update List of Files
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"- Update List of Open Windows." The macrosheet is automatically saved as soon as

the OK button is selected so when The Window Meister is used at a subsequent

computer session, the keys last designated remain in effect. To see these keys without

changing them, select this command, view the dialog box, then select cancel in the dialog

box. Suggestions for equivalents: p, w, W, and u. Be sure that these keys do not

conflict with any others in your Excel session. Whatever key is set must be

depressed with the command and option keys to invoke the macro with the keyboard. 

• Close zWNDMSTR

Closes zWNDMSTR.xlw & z_Macros.xlm and deletes the commands of the "W"

menu. Consider archiving the current List of Files before selecting this command.

• Quit Excel--NO Saves [•DANGER!•]

Exactly what it says, this macro quits Excel and closes all charts, worksheets,

and macrosheets with NO opportunity to save any of them. Of course, this macro

is dangerous because if you have not saved an Excel file, the file is gone

FOREVER, and all changes to a previously saved Excel file that were made since

the last save are gone FOREVER.
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SHAREWARE REGISTRATION FORM
for The Window Meister (TM)

     By remitting this form and an enclosed check for $10 (U.S.) or $15 (U.S.) payable to 

     Stephen R. White, I wish to register my copy of The Window Meister (TM)

     (consisting of four files: zWNDMSTR.xlw, z_Macros.xlm, z_DOCS.xlw,

     & z_Archv.xlw, and related folder(s)).

     I understand that by remitting a shareware fee, I agree to the following conditions:

    1. I am authorized to use The Window Meister (TM) on one individual microcomputer at

        one time. User authorization is transferable upon written notice to Stephen R. White.

    2. I have read, I understand, and I agree to all of the contents of Column B of z_DOCS.xlw.

    3. I am NOT authorized to, in any way, alter or use any any part of the macrosheet

        z_Macros.xlm, or the worksheet z_DOCS.xlw except as prompted by The

        Window Meister's original macros.

    4. I am NOT authorized to, in any way, modify columns A and F of zWNDMSTR.xlw.

    5. At my own risk and for my own personal use, I may modify z_Archv.xlw.

    6. I am NOT authorized to modify the file names: zWNDMSTR.xlw, z_Macros.xlm,

        z_DOCS.xlw, & z_Archv.xlw.

    7. In exchange for a shareware fee of $10 (U.S.), I will be remitted to the address, which

        I provide below, instructions to eliminate the shareware-reminder dialog boxes.  In

        exchange for a shareware fee of $15 (U.S.), I will be remitted a floppy disk contain-

        ing The Window Meister (TM) in which the shareware-notice has already been elim-

        inated. (allow ten days to four weeks for the remittance of instructions or disk).

    8. I am NOT authorized to distribute any version of The Window Meister (TM) in which

        the shareware reminder has been eliminated or otherwise not operational. I can

        distribute copies of The Window Meister (TM) only in its original condition, that is,

        only with each of its four files and related folder(s) in original condition.

    NOTE: TO ASSURE THAT YOU HAVE A VERSION OF THE WINDOW MEISTER (TM) IN 

    ORIGINAL, UNMODIFIED CONDITION, IT IS RECOMMENDED THAT YOU REMIT THE $15.

     Remit to:

     STEPHEN R. WHITE

     206 HILLANDALE DR.

     BOONE, N.C.  28607

     Your Name: ___________________________________________________

     Your Mailing Address:

       ___________________________________________________________

       ___________________________________________________________

       ___________________________________________________________

     Your telephone #:  (                )                 -

My apologies for these shareware "hoops and loops," but, unfortunately, 

some users do not take the nature of shareware seriously.
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PRINTED DOCUMENTATION: $15 (U.S.) registrations will be forwarded a copy

of this documentation printed on a laser printer.

MULTI-MACHINE DISCOUNTS: 3 to 6 registrations for one site, 10% discount.

7 to 9 registrations for one site, an additional 10% discount. Over 9 registrations

for one site, an additional 10% discount. Inquire for more details.

CREDITS: Sincerest thanks to the beta testers who provided valuable feedback

regarding an earlier version of The Window Meister.

I have NOT experimented with how The Window Meister handles Excel's add-in macros.

Similarly, I have not experimented with how it works with Excel 4.0.

After a copy of The Window Meister has been opened several times, the shareware

reminder becomes somewhat more intrusive: It becomes much bigger and slows you

up for increasingly longer periods of time. Register to eliminate the reminder!

If you have trouble reaching me at the above address, you might be able to obtain a

forwarding address from the Dept. of Political Science/Criminal Justice;

Appalachian State University; Boone, North Carolina 28608. Similarly, the

Department might forward mail to me in the event I move. My current bitnet and

internet addresses are WHITESR@APPSTATE and WHITESR@CONRAD.APPSTATE.EDU

(as of July 20, 1992 ).

 --Steve White             
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